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Overview of Hyperlinking in Federal Court 
 

In the internet research world, hyperlinks are a standard way of “drilling down” for 
more detail or specific information. Just as all web pages contain links to other pages, cases 
downloaded from legal research services such as Westlaw or Lexis contain links to the 
cases, statutes, articles, or other sources cited within the opinion. The links allow immediate 
access by the reader to these referenced materials.  
 

Attorneys can include links to cited law and CM/ECF filings in their documents filed 
in CM/ECF, adding another level of persuasion to their writing. Hyperlinks in briefs and 
other court filings provide quick, easy, and pinpoint access to particular sections of a case, 
or to specific filings in the court’s record. The attorney can thereby highlight the precise 
issue presented, and the specific evidence and controlling or persuasive law the court 
should consider.  
 

Hyperlinks in court filings are very beneficial for court chambers. Court submissions 

which include links to relevant case law and case filings are easy for chambers staff to 

review. The attorneys’ arguments can be immediately verified in the context of the relevant 

law. The judge or judicial clerk is able to read the text of the cited case law on one screen 

while reading the attorney’s brief on the other. And if a brief contains links to referenced 

exhibits, and even to specific pages within those exhibits, the judge or judicial clerk can 

access the relevant evidence without having to navigate through the CM/ECF record. 

Particularly when dealing with large and complex cases, links save chambers considerable 

time and effort. Links make it easy for the court to verify – and adopt – the positions taken 

by an advocate. 
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Types of Permissible Hyperlinks 
Subject to the court’s local rules, the following types of hyperlinks are 

typically allowed in court documents. 
 

Internal Links For example, the Table of Contents located at the 

beginning of this Guide. 

Links to documents 

previously filed on 

CM/ECF 

 

 
 

Links to attachments and 

exhibits being filed with 

your brief 

 

Note:  Evidence must be filed of record.  A hyperlink to 

a public website where evidence can be found is not a 

substitute for filing evidence in support of a motion. 

Links to case and statute 
citations 

 

 
 

Note:  Unless a cited case 

cannot reasonably be 

found from a public source, 

it is not necessary to attach 

copies of cases or statutes 
to your brief. 

For example: 
 

Westlaw, 
 

 
 

Lexis, 

 

 
or court websites. 
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Creating a Hyperlinked Table of Contents 
 

A  table  of  contents  in  a W ord  document  can  include  internal  hyperlinks  

for navigating the document.  W hen the document is converted to PDF format, 

these links will become bookmarks in the PDF document. 
 

Although  there  are several  methods  for  creating  a table  of  contents  in W 
ord 

2010,  the  one  most  useful  to  attorneys  (and  discussed  below),  is  to  create  

the document, include any headings as you write, and then: 

• Mark and format the headings to be included in the table of contents; 

• Generate and insert the table of contents; and 

• Edit as needed. 
 

Marking and Formatting Table of Contents Entries 
To mark and format entries to be included in the table of contents: 

 
 

STEP 
 

ACTION 

1 
 

Create your document, inserting all headings with the format of your 

choice. 

2 
 

Using your cursor, scroll over and 

select the heading you want to include 

in the table of contents. 
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3 
 

From the Styles 

section on your 

Home tab, 
 

 
 

Click the down arrow in the right 

lower corner. 
 

 
 

A drop down list will appear. 
 

 
 

Note:  There are 9 pre-formatted Heading Styles 

available in MS W ord, but only 2 may be visible in your 

styles drop-down menu.  Additional heading options (3 

through 9) will appear, as you make your selections. 

For example, when you select and apply Heading 2, 

the Heading 3 option will appear and be available for 
the next heading level, and so on. 

 

  



Attorney Guide to Hyperlinking in the Federal Courts 

Revised June 6, 2014  Page 6 of 33 

 

 

4 
   

If… Then… 

You want the 

text of the table 

of contents 

entries to 

match the 

headings 

already 

created within 

your document 

(e.g. font, font 

color, bold, 

etc.): 

 

Use your cursor to select the heading to be included in 

the table of contents. 
 

 
 

From the Styles list, Right-click the heading level you 

wish to apply. In the box that appears, select: 
 

Update Heading [x] to Match Selection. 
 

Continue until a heading style has been applied to all 

heading levels within your brief. 

You want to: 
 

Set a standard 

format (e.g. 

font, font color, 

bold, etc.), for 

all headings and 

table of contents 

entries created 

with your W ord 

program, 
 
 

Or 
 
 

Change the 

heading 

format in the 

brief already 

created: 

 

From the Styles list, 
 

Right-Click the heading 

level you wish to modify. 
 

In the box that appears, 
select Modify to open the 

Modify Style box. 
 

 
 
 

Choose text: 
 

• font 
 

• font size 
 

• appearance 
 

• color 
 

• justification 
 

• line spacing 
 
 
 
 

Save settings for: 

• only in this document, or 

• all documents created using your standard templat 

• Add to Quick Style List. 
 

Click OK. 

Scroll through your document.   For each heading, select the heading text 

with your cursor, then click the heading style to be applied. 
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Generating and Inserting the Table of Contents 
To add the Table of Contents to your document: 

 

 

STEP  ACTION 

 
Place your 

cursor in the 

document at 

the location you 

want to insert 

the table of 

contents. 
 

Add a title for 
the Table of 
Contents. 

 

Enter a few 

hard returns. 
 

Control + Enter 

to insert a page 

break. 
 

Place your 

cursor where 

the table of 

contents 

entries should 

begin. 
 
 
 
 

From the 
 

References tab 

of your W ord 

ribbon, 
 

Select 
 

Table of 
Contents, and 

from the menu 
that appears, 

 

Select: 
 

Insert Table of 

Contents. 
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Make selections for 

the appearance of 

the table of 

contents. 
 

Click OK. 
 

Note:  If your 

table has more 

than three levels, 

you must set 

Show levels to 

the correct 

number. 
 

Note:  The “Use 

hyperlinks instead 

of page numbers” 

must be checked 

or the table of 

contents will not 

have active links 

upon conversion 

to PDF. 
 

The Table of 

Contents, with 

active section 

links, will be 

inserted into your 

document. 
 

Note:  You can 

manually modify 

the page numbers 

to appear as other 

links in your 

document, (e.g. 

blue and 

underlined). 
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Editing the Table of Contents (if needed) 
Inserting the Table of Contents may result in page break changes.  For 

example, hard page breaks  or extra  lines that were added  during  drafting  

to adjust the overall look of the document may no longer be needed, or 

some may now need to be added. 

If the brief was modified after the table of contents was inserted: 
 

 

STEP  ACTION 
 

From the reference tab on 

the W ord ribbon, select 

Update Table. 
 

 
 
 
 
 
 
 
 
 

Select 
 

Update page numbers 

only. Click OK. 

Note:  If you have added 

or changed a heading, 

choose Update entire 

table. 
 

 

When the entire document is complete, using MS W ord, Save the document as 
a 
PDF or Create PDF in accordance with the instructions in this Guide. 

 

Note:  Do not Print to PDF.  All active links in your Word document 
become inactive in PDFs created using Print to PDF. 
 

Drafting Documents to Include Links to CM/ECF 
 

If you are creating a document which will include links to documents filed on 

CM/ECF,  use a consistent  citation format that cites the CM/ECF  filing number  

along with the CM/ECF page number.  For example: 

 
STEP  ACTION 

 

1  Download the filings from CM/ECF, and save them in your computer. 

Reminder: You can download a document from CM/ECF one time 

for free when you receive the Notice of Electronic Filing.   Charges  

apply to each additional download of the same document. 
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 STEP ACTION 

2 Documents downloaded from CM/ECF will include a header that 

identifies the CM/ECF filing number and the page numbers within that 

filing. 

3 When drafting your brief, cite to the CM/ECF filing number and 

CM/ECF page number to which you are citing.  For example: 

Assume you are citing to the following page of evidence. 

 

The citation within the brief could appear as follows: 

The Plan included a Trust Agreement.  (Filing No. 13-1, at CM/ECF p. 3). 
 

Note:   A consistent citation format is necessary  when using CM/ECF 

LinkBuilder, an automated method for adding links to CM/ECF filings. 

Gathering URLs for Links for Citations to the Record 
Now that the filing numbers and associated page numbers are in the brief, 

you can manually add links to the electronic record.  You may gather these 

links from: 

• saved Notices of Electronic Filing (no charge); or 

• the docket sheet on PACER (PACER charge applies). 
 

To obtain the url for the CM/ECF document without incurring a PACER charge: 
 

STEP ACTION 

1 Collect and save on your computer the Notice of Electronic Filing 

(NEF) for all filings in the case. 

2 When you later need the link for the 

document cited, 

--retrieve the NEF for that document, 

--right-click on the Document 

Number, and from the drop-down 

menu that appears, 

Select Copy Link Location. 
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To obtain the url for the document from the PACER docket sheet (PACER 

charge applies): 
 

STEP ACTION 

1 Open the CM/ECF docket sheet for the case and scroll to the cited 
docket filing. 

 

2 If linking to the main CM/ECF filing,  

right-click on the docket filing number, 

 
 

and  Copy shortcut.  

 

If linking to a sub-file within a CM/ECF filing number: 

Right-click on the sub-
filing number in the 
docket text and, 

 

select Copy Shortcut.   
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Formatting the Appearance of the Links Inserted 
Before inserting links into a document, you may choose how those links 

will appear in the final document.  For example, do you want them to 

appear: 

blue and underlined, 

bold and black, 

black and italicized, or 

some other 

appearance? 

To select the appearance of the links in your document: 
 

STEP ACTION 

1 On the Home tab, 

click on the tiny arrow under 

Changes Styles. 

2 A drop down menu will appear. 

Scroll down until you see Hyperlink. 

Right-click on Hyperlink, and from the 
choices that appear, 

 

select Modify. 
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3 
 

A Modify Style box will 

appear. 
 

Change the color, font, and 
underlining, etc. for hyperlinks. 

 

Note:  Choose a specific font 

and font size for the linked text 

only if the linked text font and 

font size should appear 

different from that of the 

document text.  Otherwise, 

leave the font and font size 

selections blank. 
 

Click OK. 

Linking to CM/ECF Documents 
 

Using LinkBuilder to  Insert Links to Documents Previously Filed on 
CM/ECF 

The CM/ECF LinkBuilder add-in for W ord automates the creation of cross- 

document hyperlinks between filings in the federal court’s CM/ECF system. 

LinkBuilder will search a Microsoft W ord document for citations to CM/ECF 

filings and insert a hyperlink to the corresponding file in the CM/ECF system. 

LinkBuilder can recognize and link to attachments to the record, as well as page 

specific references to create pinpoint access to specific information in the case. 
 

For more information and to download the LinkBuilder tool, visit 

http://www.ned.uscourts.gov/internetDocs/cmecf/LinkBuilderforMSW 

ord.pdf 

 

Manually Inserting Links to Documents Previously Filed on CM/ECF 
To manually add the links you have copied from the docket to the MS W ord 
document you are drafting: 
 

STEP ACTION 

1 In the brief, use your cursor to select the citation to which a hyperlink 
will be added. 

 

http://www.ned.uscourts.gov/internetDocs/cmecf/LinkBuilderforMSWord.pdf
http://www.ned.uscourts.gov/internetDocs/cmecf/LinkBuilderforMSWord.pdf
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STEP ACTION 

2 Select the Insert tab on the MS Word ribbon, then select Hyperlink. 
An Insert Hyperlink dialog box will appear. 

 

Note: The text you selected will automatically appear in the “Text to 
display” line. 

3 Place your cursor in the Address box of the Insert Hyperlink dialog 
box. Right-click. From the drop-down that appears, select Paste. 

 

4 The link to the first page of the filing will appear. 

To link to the filing only, or to only page 1 of the filing, click OK. The 
link to the citation will be added in your brief. 
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STEP ACTION 

5 To link to the specific page number of the CM/ECF filing that you are 
citing, 

In the address box, scroll to or place your cursor at the end of the link 
address. 

Add the following text: ?page=<page number> .  For example, 

To link to page number 3 of a filing, add ?page=3.  Click OK and the 
link to the page will be added to the citation in the brief. 

 

Note: Use the page numbers assigned by CM/ECF when linking to 
pages in documents filed in CM/ECF.  Do not use Bates numbers or 
other numbering assigned to the record by the parties. 

Note: While the document remains in an MS Word format, the link will 
go only  to the first page of the document.  But upon conversion to 
PDF (see instructions below), the PDF link will go to the specific page 
you cited. 

6 Convert the brief to a PDF following the instructions below. 

7 File the PDF version of the document in CM/ECF. 

Note: It is not necessary to re-file or re-attach the documents to which 
you are linking if they have been previously filed in CM/ECF. 

Adding Links to Attachments to the Document being Filed 
If a document cited in your brief has not previously been filed on CM/ECF, you 
may link to the document within your order only if the document is filed as an 
attachment to your brief. Follow the steps below to add active hyperlinks to 
documents you will be filing as attachments in CM/ECF. 
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STEP ACTION 

1 Save all the attachment documents you will cite into a single folder in 
your computer. The documents must be in PDF format. 

2 While drafting your brief, include the citations to the documents saved 
in your computer.  

3 Using your cursor, select the text to which a link will be added. 

 

4 On the Insert 
ribbon,  

select Hyperlink. 

 

5 In the Insert Hyperlink dialog box: 

 Navigate to cited file 
saved on your 
computer;  

 Select the file; and  

 Click OK. 

6 A link to the file will be added to the text. If you hover over the link with your 
cursor, you will see the link address. 

 

Add links to all the citations in your brief accordingly. 

Note: Specific page links can be added by following the directions in the 
previous section. Use the PDF page number, not a Bates number or footer 
page number, for the citation. 

7 Save the order as a PDF as described in these instructions. 
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STEP ACTION 

8 File the brief and evidence as follows: 

a Following the normal procedure for filing orders on CM/ECF, 
browse to and select your brief with links as the main 

document. 

 

b Browse to and select as an Attachment each PDF file 
to which a link was created in your brief.

 

c Using the drop-down list, select the type of document 
attached, and provide a written description of the 
document.   (Note:  The written description will become 
the name assigned as a PDF bookmark when the file is 
downloaded by the court.  However, a unique 
description is needed if similarly labeled documents are 
cited.)   

 

 

R
e

Repeat the foregoing steps until all cited evidence is 
filed as an attachment to your brief. 

d When all evidence attachments have been added to 
the brief, click Next and complete the remaining steps 
for filing the brief on CM/ECF. Once filed, the links in 
the brief will link directly to the evidence filed of record 
as attachments to the brief. 
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Automated Links to Legal Citations 
 Links to legal citations can be added manually or, assuming the software is 
compatible with your computer and word processing software, by using automated 
linking software available through Westlaw or Lexis.   

Access to Linking Software 

Tool Cost URL 

Westlaw InsertLinks Must purchase a West 
BriefTools subscription. 

Estimated cost:  $100/month 
for small firms; 

$300 to 500/month for larger 
firms (10 licenses) 

http://legalsolutions.thomsonre
uters.com/law-
products/solutions/brief-
tools?searchterms=brief+tool 

 

Shepard’s Links 
2008 

Lexis is currently not selling a 
software subscription which will 
insert links to documents that 
will remain active upon 
conversion to PDF.  The last 
version of such software was 
created in 2008 and can be 
downloaded from the 
Lexis/Nexis website for free. 

http://support.lexisnexis.com/ln
download/record.asp?ArticleID
=6056 

 

Note: The Shepard’s 
BriefSuite dictionary is getting 
old and may not recognize 
some of the newer reporters. 

Its accuracy as a linking tool is 
inconsistent.  

Lexis for Microsoft 
Office  

This Lexis software product will 
add links for research and 
drafting purposes, but those 
links are lost upon conversion 
to PDF.  Lexis is investigating 
the issue. 

http://www.lexisnexis.com/en-
us/products/lexis-for-microsoft-
office.page 

 

  

http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://legalsolutions.thomsonreuters.com/law-products/solutions/brief-tools?searchterms=brief+tool
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://support.lexisnexis.com/lndownload/record.asp?ArticleID=6056
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
http://www.lexisnexis.com/en-us/products/lexis-for-microsoft-office.page
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Linking Software—Compatibility Information 
The following graph outlines the compatibility of Shepard’s Links 2008, West 
InsertLinks, and Lexis Links for Microsoft Office for inserting links into MS Word 
and WordPerfect documents with a Windows XP (SP3) 2GB Memory, Windows 
Vista (SP2) 4GB Memory, or Windows 7 – 4GB Memory computer.* 

 Shepard’s Links 
2008 

Lexis for 
Microsoft Office 

West 
InsertLinks 

MS Word 2010  X** X*** 
    
MS Word 2007  X** X*** 
    

MS Word 2003 X  X*** 
    

MS Word 2000 X   
    

WordPerfect X6****    
    
WordPerfect X4 – X5   X 

    
WordPerfect X3  X  X 
    
WordPerfect 10 – 12 X   

*    The West and Lexis linking software programs cannot be used on Apple computers.  
Moreover, although Shepard’s Links was not designed to operate on Windows Vista 
and Windows 7 (as reflected in the Lexis literature), it is working on these computer 
systems.   

** Lexis for Microsoft Office is being developed and tested.  However, in its current 
stage of development, any links added by Lexis for Microsoft Office are being stripped 
out upon conversion to PDF.  Lexis is investigating this issue. 

*** Westlaw product information states InsertLinks is compatible with both 32- and 64-bit 
Microsoft Word.  However, while it works well with 32-bit Word, InsertLinks is not fully 
compatible or useful with 64-bit Word.  

**** West currently has no linking software compatible with WordPerfect X6.  West 
indicates it may develop and release this product during the summer of 2013. 
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Westlaw InsertLinks 
InsertLinks is a Westlaw computer software program which scans Microsoft Word 
or Corel WordPerfect1 documents to locate legal citations, and then automatically 
inserts hyperlinks to the Westlaw internet address (url) for those citations into the 
word processing document.   

See attached InsertLink example-Word  

InsertLink example-WordPerfect 

Installing West InsertLinks  
InsertLinks is part of the West BriefTools suite, and a BriefTools 
subscription is required in order to use this software. 

 The current West BriefTools product is Version 2.7.2039, which 
was updated on December 10, 2012. 

 The attached BriefTools Software Download instructions  
outline the system requirements and provides instructions on how 
to install West BriefTools. 

Using West InsertLinks 
Once InsertLinks software is installed, Westlaw links can be installed 
automatically in Microsoft Word documents using the following steps:  

STEP ACTION 

1 With the Microsoft Word document to which you are adding 
links open on your screen: 

 

Select the Westlaw Solutions tab on the Word ribbon. 

2 The West BriefTools options will open. 

 

 Select InsertLinks. 

                                                      
1
 Currently, InsertLinks is not compatible with, and cannot be used for, automatically inserting links into 

WordPerfect X6 documents.  It does, however, work with prior versions of WordPerfect.  
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STEP ACTION 

3 The InsertLinks software will begin searching the document 
for citations and inserting the appropriate links. 

 
 

The box depicted above will disappear when the process is 
complete and all links are installed. 

 

Shepard’s Links 2008 
Shepard’s Links is a Lexis computer software program which scans Microsoft 
Word or Corel WordPerfect2 documents to locate legal citations, and then 
automatically inserts hyperlinks to the Lexis internet address (url) for those 
citations into the word processing document.   

Reminder:  Although free, Shepard’s links has not been updated since 2008 and 
provides inconsistent auto-linking results. 

Installing Shepard’s Links  
Shepards Links is part of the Shepard’s BriefSuite. 

 Shepard’s BriefSuite has not been updated since 2008. 

 The attached BriefSuite software download instructions  
provide a step-by-step description on how to install Shepard’s 
BriefSuite.  

  

                                                      
2
 See compatibility graph above.  
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Manually Inserting Hyperlinks 
As previously described, hyperlinks to documents filed on CM/ECF can be 

manually added to a document about to be filed.  It is also possible to manually create 
links to documents available through commercial legal websites (e.g., Lexis or 
Westlaw), and those posted on the court’s website (Local Rules).   

Manually adding links can be labor intensive if the document is long, but the 
process is not difficult.  And even if you are primarily using software to add links to a 
document, understanding the underlying mechanics of hyperlinking within WordPerfect 
and Word documents is helpful and may be necessary if, for example, you need to 
make corrections to the automatically created links. 

Manually Creating Links to Online Research Resources 
The process for manually adding links to Westlaw, Lexis, Google Scholar, or any 
other online research resource (LoisLaw, FastCase, etc.,) is the same. 

STEP ACTION 

1 In the brief, use your cursor to select the citation to which you are 
adding a link. 

 

2 Sign into the legal research website and open the cited document.   

Select the url address for the document. 

Right-click, and Copy the address.  See e.g.,  

 

OR 

 

OR 

 
 

Note:  Check your local rules for any authority or limitations on the 
legal research websites to which links are permitted. 
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STEP ACTION 

3 a Select the Insert ribbon, then select Hyperlink. An Insert 
Hyperlink dialog box will appear. 

 

Note: The text you selected will automatically appear in the “Text 
to display” line. 

b Place your cursor in the Address box of the Insert Hyperlink 
dialog box. Right-click. From the drop-down that appears, 
select Paste. 

 

Click OK.  

c 
The link to the citation will be added in your order. 

 
 

Manual Links to Court Websites 
You may wish to cite to published opinions on a court’s website, or to the court’s 
local rules.  To do so: 

STEP ACTION 

1 In your brief, select the text to be linked. 
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STEP ACTION 

2 Locate and copy the url address for the citation.  See e.g.,  

 

OR 

 

3 Referring to the previous section, “Manually Creating Links to 
Online Research Resources,” complete Step 3.  
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Hyperlinking Guide for Attorneys Practicing in US District Court 
 
Create Bookmarks in a PDF 

A bookmark is a type of link within Acrobat PDF documents. Each 

bookmark goes to a different view or page in the document. They can 

mark places in a document for easy access later.  Follow the steps in the 

table below to add bookmarks to your PDF files. 
 

 

Step 
 

Screen 
 

1.  Click the Bookmark tab on the left 

side of the Adobe Acrobat window to 

open the bookmarks panel. 

 
 

 
 

2.  Navigate to the page where you want 

the bookmark. 
 
 

In the Bookmarks pane, click the New 

Bookmark icon. 
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3.  A new bookmark will appear as 
 

 
 

Type a name for the bookmark. 
 
 
 

Note:  If you highlight text on the page 

before clicking the New Bookmark 

button, the selected text will 

automatically become the name of the 

bookmark. 

 

 
 

 

4.  Repeat steps 2-3 until all bookmarks 

are placed. 

 

 

To ensure that the bookmarks are 

displayed when the document is 

opened, we need to set the view 

property. 

5.  From the File menu, choose 

Properties. 

 
6.  Click on the Initial View tab. 

 
7.  From the Navigation tab list, choose 

Bookmarks Panel and Page or 

Attachments Panel and Page depending 

on your situation. 
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Final Editing 
Removing Links 

To remove a specific link in a Word document: 

Place your cursor over the link, 

Right-click, and from the drop-down 
that appears,  

click Remove Hyperlink. 

 

 

To remove all links in a Word document: 

Press Ctrl + A to select the entire document, then 

Ctrl + Shift + F9. 

 

Editing Linked Text 
To make additions to or change hyperlinked text in a Word document: 

1. Place your cursor at the end of the linked text. 

2. Use the back arrow on your keyboard to move your cursor in the 
linked text to the position where the text must be added or 
changed, and  

3. Type in your changes. 

Or 

Place your cursor over the link, 

Right-click, and from the drop-down 
that appears, and  

click Edit Hyperlink. 

 

In the Edit Hyperlink box that opens,  

Type any changes in Text to display. 

 

Click OK. 
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Publish to PDF—Retaining the Hyperlinks 

All documents filed in CM/ECF are in PDF format, so all documents created for 
filing must be converted to a PDF document.  To include hyperlinks in your filed 
documents, place all the links into the document using your word processing system 
before converting the document to a PDF format. 

Once all links are in the word processing version of your document, use your 
word processing software to save or convert your briefs, or other documents you have 
created for filing, in a PDF format.   

Note:  Do NOT use Print to PDF to create a PDF of an order with hyperlinks–the 
hyperlinks will be lost.  Do NOT print the document and scan it to PDF format. 

Conversion to PDF 
MS Word has several methods for saving (“publishing”) a document in PDF 
format, including the following methods: 

STEP ACTION 

1 Select the File 
tab on the MS 
Word ribbon; 

 

from the drop-
down menu, 
select  
Save and 
Send; 

and from the 
choices now 
available,  

choose 
Create Adobe PDF from the File Types list,  
 

then   
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STEP ACTION 

2 Navigate to the location where you want to save the document. 

Name the document and click Save. 

 

Check View Result if you want the PDF document created to open 
upon conversion. 

3 After the document is published to PDF, you may upload it to CM/ECF 
using typical filing processes.  With the exception of filing a document 
with links to its own attachments (discussed previously), no special 
steps are needed for filing a hyperlinked document on CM/ECF. 

 

Note: If you have Adobe Acrobat Standard or Pro loaded on your computer, you 
may also add the Adobe Acrobat tab and ribbon to your MS Word ribbons and 
use the Acrobat ribbon to convert documents to PDF. 

To do so: 

Select the File tab on the MS Word ribbon. 

Choose Options.  
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Select Customize 
Ribbon. 

Add the Acrobat tab. 

Click OK 

An Acrobat tab will now appear on the MS Word ribbon, and will 
continue to do so hereafter. 

 

After the Acrobat tab is added, save a document as a PDF by 
selecting the Acrobat tab, and then Create PDF. 

 

After the document is published to PDF, you may upload it to 
CM/ECF using typical filing processes.  With the exception of filing a 
document with links to its own attachments (discussed previously), 
no special steps are needed for filing a hyperlinked document on 
CM/ECF. 

  



Attorney Guide to Hyperlinking in the Federal Courts 

Revised June 6, 2014  Page 31 of 33 

 

Additional Tips 
Viewing a Website Location Opened from a Link in a CM/ECF Filing: 

When opening a PDF document filed on CM/ECF, make sure you are opening 
PDFs in your PDF software and not within the Web browser itself.  Opening the 
CM/ECF documents in the web browser will result in unnecessary toggling 
between the document opened on CM/ECF and any website locations opened 
from links within that CM/ECF document, and will make it difficult or impossible to 
display the CM/ECF document on one screen and the website location on 
another.   

For those who use Adobe Acrobat, this setting adjustment is made as follows: 

With an Adobe Acrobat 
document open, 

Click Edit,  

then Preferences.   

 

From the Categories,  

scroll and select Internet. 

 

Make sure Display PDF in 
browser is not selected.  

 

Click OK. 

 

After you change this setting, you will need to close and reopen your Web 
browser before opening CM/ECF filings. 
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Formatting the Appearance of the Links Inserted 
Before inserting links into a document, you may choose how those links will 
appear in the final document.  For example, do you want them to appear: 

blue and underlined,  

bold and black,  

black and italicized, or 

some other appearance? 

To select the appearance of the links in your document: 

STEP ACTION 

1 On the Home tab,  

click on the tiny arrow under  

Changes Styles.  

2 A drop down menu will appear.   

Scroll down until you see Hyperlink. 

Right-click on Hyperlink, and from the 
choices that appear,  

select Modify. 

3 A Modify Style box will 
appear. 

Change the color, font, and 
underlining, etc. for hyperlinks. 

Note:  Choose a specific font 
and font size for the linked text 
only if the linked text font and 
font size should appear 
different from that of the 
document text.  Otherwise, 
leave the font and font size 
selections blank. 

Click OK. 
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Optimized PDFs to reduce file size 
Large documents or documents containing forms, photos or graphics should be 
saved as an optimized PDF to reduce file storage size.  Select File and Click 
Save As.  From the Save as type dropdown menu, select PDF.  From the 
Optimize for radio buttons, Select Minimum size (publishing online).  Click 
Save. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This manual was based on the instructional guide produced by 

Magistrate Judge Cheryl Zwart of the District Court of Nebraska.  

Please share your comments, questions, corrections, and experiences 

with hyperlinking or using this Guide by contacting: 

 

 IT Department 

US District Court for the Central District of California  

(213) 894-6133  


